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Lab Work 01 – Downloading and Installing 
Hadoop 
Downloading and Installing the Cloudera Virtual Machine 

Learning Goals 

In this activity, you will: 

 Download and Install VirtualBox.

 Download and Install Cloudera Virtual Machine (VM) Image.

 Launch the Cloudera VM.

Hardware Requirements: (A) Quad Core Processor (VT-x or AMD-V support recommended), 64-

bit; (B) 8 GB RAM; (C) 20 GB disk free. How to find your hardware information: Open System by 

clicking the Start button, right-clicking Computer, and then clicking Properties. Most computers 

with 8 GB RAM purchased in the last 3 years will meet the minimum requirements. You will need 

a high speed internet connection because you will be downloading files up to 4 Gb in size. 

Instructions 

Please use the following instructions to download and install the Cloudera Quickstart VM with 

VirutalBox before proceeding to the Getting Started with the Cloudera VM Environment video. 

The screenshots are from a Mac but the instructions should be the same for Windows. Please 

see the discussion boards if you have any issues. 

1. Install VirtualBox. Go to https://www.virtualbox.org/wiki/Downloads to download and install

VirtualBox for your computer. The course uses Virtualbox 5.1.X, so we recommend 

clicking VirtualBox 5.1 builds on that page and downloading the older package for ease of 

following instructions and screenshots. However, it shouldn't be too different if you choose to use 

or upgrade to VirtualBox 5.2.X. For Windows, select the link "VirtualBox 5.1.X for Windows 

hosts x86/amd64" where 'X' is the latest version. 

2. Download the Cloudera VM. Download the Cloudera VM

fromhttps://downloads.cloudera.com/demo_vm/virtualbox/cloudera-quickstart-vm-5.4.2-0-

virtualbox.zip. The VM is over 4GB, so will take some time to download. 

3. Unzip the Cloudera VM:

Right-click cloudera-quickstart-vm-5.4.2-0-virtualbox.zip and select “Extract All…” 

4. Start VirtualBox.

5. Begin importing. Import the VM by going to File -> Import Appliance

https://www.virtualbox.org/wiki/Downloads
https://www.virtualbox.org/wiki/Download_Old_Builds_5_1
https://downloads.cloudera.com/demo_vm/virtualbox/cloudera-quickstart-vm-5.4.2-0-virtualbox.zip
https://downloads.cloudera.com/demo_vm/virtualbox/cloudera-quickstart-vm-5.4.2-0-virtualbox.zip
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6. Click the Folder icon.

7. Select the cloudera-quickstart-vm-5.4.2-0-virtualbox.ovf from the Folder where you

unzipped the VirtualBox VM and click Open. 

8. Click Next to proceed.
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9. Click Import.

10. The virtual machine image will be imported. This can take several minutes.

11. Launch Cloudera VM. When the importing is finished, the quickstart-vm-5.4.2-0 VM will

appear on the left in the VirtualBox window. Select it and click the Start button to launch the VM. 
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12. Cloudera VM booting. It will take several minutes for the Virtual Machine to start. The

booting process takes a long time since many Hadoop tools are started. 

13. The Cloudera VM desktop. Once the booting process is complete, the desktop will appear

with a browser. 
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Copy your data into HDFS 

Learning Goals 

By the end of this activity, you will be able to: 

 Interact with Hadoop using the command-line application.

 Copy files into and out of the Hadoop Distributed File System (HDFS).

Instructions 

1. Open a browser. Open the browser by click on the browser icon on the top left of the screen.

2. Download the Shakespeare. We are going to download a text file to copy into HDFS. Enter

the following link in the 

browser: http://ocw.mit.edu/ans7870/6/6.006/s08/lecturenotes/files/t8.shakespeare.txt 

Once the page is loaded, click on the Open menu button. 

Click on Save Page 

Change the output to words.txt and click Save. 

http://ocw.mit.edu/ans7870/6/6.006/s08/lecturenotes/files/t8.shakespeare.txt
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2. Open a terminal shell. Open a terminal shell by clicking on the square black box on the top

left of the screen. 

Run cd Downloads to change to the Downloads directory. 

Run ls to see that words.txt was saved. 

3. Copy file to HDFS. Run hadoop fs –copyFromLocal words.txt to copy the text file to HDFS.

4. Verify file was copied to HDFS. Run hadoop fs –ls to verify the file was copied to HDFS.

5. Copy a file within HDFS. You can make a copy of a file in HDFS. Run hadoop fs -cp

words.txt words2.txt to make a copy of words.txt called words2.txt 

We can see the new file by running hadoop fs -ls 

6. Copy a file from HDFS. We can also copy a file from HDFS to the local file system.

Run hadoop fs -copyToLocal words2.txt . to copy words2.txt to the local directory. 
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Let's run ls to see that the file was copied to see that words2.txt is there. 

7. Delete a file in HDFS. Let's the delete words2.txt in HDFS. Run hadoop fs -rm words2.txt

Run hadoop fs -ls to see that the file is gone. 

Run the WordCount program instructions 

Learning Goals 

By the end of this activity, you will be able to: 

 Execute the WordCount application.

 Copy the results from WordCount out of HDFS.

1. Open a terminal shell. Start the Cloudera VM in VirtualBox, if not already running, and open a
terminal shell. Detailed instructions for these steps can be found in the previous Readings.

2. See example MapReduce programs. Hadoop comes with several example MapReduce

applications. You can see a list of them by running hadoop jar /usr/jars/hadoop-examples.jar. We 

are interested in running WordCount. 
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The output says that WordCount takes the name of one or more input files and the name of the 

output directory. Note that these files are in HDFS, not the local file system. 

3. Verify input file exists. In the previous Reading, we downloaded the complete works of

Shakespeare and copied them into HDFS. Let's make sure this file is still in HDFS so we can run 

WordCount on it. Run hadoop fs -ls 

4. See WordCount command line arguments. We can learn how to run WordCount by

examining its command-line arguments. Run hadoop jar /usr/jars/hadoop-examples.jar 

wordcount. 

5. Run WordCount. Run WordCount for words.txt: hadoop jar /usr/jars/hadoop-examples.jar

wordcount words.txt out 

As WordCount executes, the Hadoop prints the progress in terms of Map and Reduce. When the 

WordCount is complete, both will say 100%. 
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6. See WordCount output directory. Once WordCount is finished, let's verify the output was

created. First, let's see that the output directory, out, was created in HDFS by running hadoop fs 

–ls

We can see there are now two items in HDFS: words.txt is the text file that we previously 

created, and out is the directory created by WordCount. 

7. Look inside output directory. The directory created by WordCount contains several files.

Look inside the directory by running hadoop –fs ls out 

The file part-r-00000 contains the results from WordCount. The file _SUCCESS means 

WordCount executed successfully. 

8. Copy WordCount results to local file system. Copy part-r-00000 to the local file system by

running hadoop fs –copyToLocal out/part-r-00000 local.txt 

9. View the WordCount results. View the contents of the results: more local.txt

Each line of the results file shows the number of occurrences for a word in the input file. For 

example, Accuseappears four times in the input, but Accusing appears only once. 
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TODO 
1. Follow all steps described above installing VM with Hadoop.

2. Write down all HDFS commands typing “hadoop fs”.

3. Choose two examples of mapreduce application from the list (ask your teacher) and run them on

different input file(s) to prove benefits from usage of mapreduce application for big data. 

4. Prepare a report for this lab work.



Lab Work 02 – How to Create a 
Simple MapReduce Application 

Learning Goals 

In this lab work, you will 

- Download and install Eclipse IDE 

- Create Java projects for Hadoop 

- Learn the structure of MapReduce application 

Install Java 8 
Download Java 8 from the link: http://www.oracle.com/technetwork/java/javase/downloads/jdk8-

downloads-2133151.html  

a. Set environmental variables:

i. User variable:

- Variable: JAVA_HOME 

- Value: C:\java  

ii. System variable:

- Variable: PATH  

- Value: C:\java\bin 

b. Check on cmd, see below:

Install Eclipse 
Download it from the link: https://eclipse.org/downloads/ and extract it into C drive. 

a. Set environmental variables:

i. User variable:

- Variable: ECLIPSE_HOME 

- Value: C:\eclipse  

ii. System variable:

- Variable: PATH  

- Value: C:\eclipse \bin 

b. Download “hadoop2x-eclipse-plugin-master.” You will see three Jar files on the path

“hadoop2x-eclipse-plugin-master\release.” Copy these three jar files and pate them into 

“C:\eclipse\dropins.”  

c. Download “slf4j-1.7.21.” Copy Jar files from this folder and paste them to

“C:\eclipse\plugins”. This step may create errors; when you will execute Eclipse, you will see 

errors like org.apa…..jar file in multiple places. So, now delete these files from all the places 

except one.  



Download Hadoop 
This step is optional if you’ve already installed Hadoop. 

Actually, you will need jar extra libraries from Hadoop folders. 

Download Hadoop 3.0.0 from the link: 

http://www.apache.org/dyn/closer.cgi/hadoop/common/hadoop-3.0.0/hadoop-3.0.0.tar.gz 

and put extracted files into your local drive (not C:\). 

How to create a new MapReduce project in Eclipse 
1. Open Ellipse 

2. Click File -> New Project -> Java project 

 

 
3. Click next and add external Jars for MapReduce.  

 

Copy all the Jar files from the locations “D:\hadoop-3.0.0\” 

http://www.apache.org/dyn/closer.cgi/hadoop/common/hadoop-3.0.0/hadoop-3.0.0.tar.gz


- \share\hadoop\common\lib 

- \share\hadoop\mapreduce 

- \share\hadoop\mapreduce\lib 

- share\hadoop\yarn 

- \share\hadoop\yarn\lib 

4. Create class file 

Right click on source, New -> Class: 

 

Click "Finish". 

 

5. Paste the following code (taken from Hadoop examples): 



import java.io.IOException; 
import java.util.StringTokenizer; 
 
import org.apache.hadoop.conf.Configuration; 
import org.apache.hadoop.fs.Path; 
import org.apache.hadoop.io.IntWritable; 
import org.apache.hadoop.io.Text; 
import org.apache.hadoop.mapreduce.Job; 
import org.apache.hadoop.mapreduce.Mapper; 
import org.apache.hadoop.mapreduce.Reducer; 
import org.apache.hadoop.mapreduce.lib.input.FileInputFormat; 
import org.apache.hadoop.mapreduce.lib.output.FileOutputFormat; 
import org.apache.hadoop.util.GenericOptionsParser; 
 
public class WordCount { 
 
  public static class TokenizerMapper  
       extends Mapper<Object, Text, Text, IntWritable>{ 
     
    private final static IntWritable one = new IntWritable(1); 
    private Text word = new Text(); 
       
    public void map(Object key, Text value, Context context 
                    ) throws IOException, InterruptedException { 
      StringTokenizer itr = new StringTokenizer(value.toString()); 
      while (itr.hasMoreTokens()) { 
        word.set(itr.nextToken()); 
        context.write(word, one); 
      } 
    } 
  } 
   
  public static class IntSumReducer  
       extends Reducer<Text,IntWritable,Text,IntWritable> { 
    private IntWritable result = new IntWritable(); 
 
    public void reduce(Text key, Iterable<IntWritable> values,  
                       Context context 
                       ) throws IOException, InterruptedException { 
      int sum = 0; 
      for (IntWritable val : values) { 
        sum += val.get(); 
      } 
      result.set(sum); 
      context.write(key, result); 
    } 
  } 
 
  public static void main(String[] args) throws Exception { 
    Configuration conf = new Configuration(); 
    String[] otherArgs = new GenericOptionsParser(conf, args).getRemainingArgs(); 
    if (otherArgs.length < 2) { 
      System.err.println("Usage: wordcount <in> [<in>...] <out>"); 
      System.exit(2); 
    } 
    Job job = Job.getInstance(conf, "word count"); 
    job.setJarByClass(WordCount.class); 
    job.setMapperClass(TokenizerMapper.class); 
    job.setCombinerClass(IntSumReducer.class); 
    job.setReducerClass(IntSumReducer.class); 
    job.setOutputKeyClass(Text.class); 
    job.setOutputValueClass(IntWritable.class); 
    for (int i = 0; i < otherArgs.length - 1; ++i) { 
      FileInputFormat.addInputPath(job, new Path(otherArgs[i])); 
    } 
    FileOutputFormat.setOutputPath(job, 



      new Path(otherArgs[otherArgs.length - 1])); 
    System.exit(job.waitForCompletion(true) ? 0 : 1); 
  } 
} 

 

6. Now we want to export it as a jar. 

Right click on WordCount project and select "Export...": 

   

Prepare input file wordcount.txt and copy it into HDFS. 

7. Run MapReduce job. 

 

Application is running 

> hadoop jar WordCount.jar WordCount wordcount.txt out 
INFO client.RMProxy: Connecting to ResourceManager at /0.0.0.0:8032 
INFO mapreduce.JobResourceUploader: Disabling Erasure Coding for path: /tmp/hadoop-
yarn/staging/user/.staging/job_1517319107770_0014 
INFO input.FileInputFormat: Total input files to process : 1 
INFO mapreduce.JobSubmitter: number of splits:1 
INFO Configuration.deprecation: yarn.resourcemanager.system-metrics-publisher.enabled is deprecated. 
Instead, use yarn.system-metrics-publisher.enabled 
INFO mapreduce.JobSubmitter: Submitting tokens for job: job_1517319107770_0014 
INFO mapreduce.JobSubmitter: Executing with tokens: [] 
INFO conf.Configuration: resource-types.xml not found 
INFO resource.ResourceUtils: Unable to find 'resource-types.xml'. 
INFO impl.YarnClientImpl: Submitted application application_1517319107770_0014 
INFO mapreduce.Job: The url to track the job: 
http://localhost:8088/proxy/application_1517319107770_0014/ 
INFO mapreduce.Job: Running job: job_1517319107770_0014 
INFO mapreduce.Job: Job job_1517319107770_0014 running in uber mode : false 



INFO mapreduce.Job:  map 0% reduce 0%                                                                      
INFO mapreduce.Job:  map 100% reduce 0% 
INFO mapreduce.Job:  map 100% reduce 100% 
INFO mapreduce.Job: Job job_1517319107770_0014 completed successfully 
INFO mapreduce.Job: Counters: 53                                                                                   
File System Counters 
                FILE: Number of bytes read=60 
                FILE: Number of bytes written=415397 
                FILE: Number of read operations=0                                                                                                  
                FILE: Number of large read operations=0 
                FILE: Number of write operations=0 
                HDFS: Number of bytes read=146 
                HDFS: Number of bytes written=38                                                                                                   
                HDFS: Number of read operations=8 
                HDFS: Number of large read operations=0 
                HDFS: Number of write operations=2 
        Job Counters 
                Launched map tasks=1 
                Launched reduce tasks=1 
                Data-local map tasks=1 
                Total time spent by all maps in occupied slots (ms)=3205 
                Total time spent by all reduces in occupied slots (ms)=3406                                                                        
                Total time spent by all map tasks (ms)=3205 
                Total time spent by all reduce tasks (ms)=3406 
                Total vcore-milliseconds taken by all map tasks=3205 
                Total vcore-milliseconds taken by all reduce tasks=3406                                                                            
                Total megabyte-milliseconds taken by all map tasks=3935740 
                Total megabyte-milliseconds taken by all reduce tasks=4182568 
        Map-Reduce Framework 
                Map input records=1 
                Map output records=4 
                Map output bytes=46                                                                                                                
                Map output materialized bytes=60 
                Input split bytes=117 
                Combine input records=4 
                Combine output records=4 
                Reduce input groups=4                                                                                                              
                Reduce shuffle bytes=60 
                Reduce input records=4                                                                                                             
                Reduce output records=4 
                Spilled Records=8 
                Shuffled Maps =1 
                Failed Shuffles=0 
                Merged Map outputs=1 
                GC time elapsed (ms)=128 
                CPU time spent (ms)=967 
                Physical memory (bytes) snapshot=379265024 
                Virtual memory (bytes) snapshot=478769152 
                Total committed heap usage (bytes)=156237824 
                Peak Map Physical memory (bytes)=279134208 
                Peak Map Virtual memory (bytes)=337829888 
                Peak Reduce Physical memory (bytes)=185753600 
                Peak Reduce Virtual memory (bytes)=236560384 
        Shuffle Errors 
                BAD_ID=0                                                                                                                           
                CONNECTION=0 
                IO_ERROR=0 



                WRONG_LENGTH=0 
                WRONG_MAP=0 
                WRONG_REDUCE=0 
        File Input Format Counters 
                Bytes Read=29 
        File Output Format Counters 
                Bytes Written=38 

 

8. Get the result to local disk from HDFS: hadoop fs -copyToLocal out. 

9. Examine the result in part-r-00000 file. 

TODO 
1. Follow all steps described. 

2. According to your variant, try to create your own Java project for one of Hadoop samples (see 

lab work #1). 

3. Examine the structure of java file, learning details of implementation. 

4. Prepare a report for this lab work. 

 



Lab Work 03 Querying Relational 
Data with Postgres

By this end of this activity, you will be able to: 

 View table and column definitions, and perform SQL queries in the Postgres shell

 Query the contents of SQL tables

 Filter table rows and columns

 Combine two tables by joining on a column

Downloading datasets 
Step 1. Start the Cloudera VM. Most of the Hands On exercises in this course use the Cloudera 

Virtual Machine, so we will download the datasets onto the VM. Start the VM in VirtualBox and 

perform the remaining steps in the VM. 

Step 2. Open a web browser. Open a web browser by clicking on the web browser icon in the 

top toolbar. 

In the web browser, enter the following for the URL: 

http://github.com/words-sdsc/coursera 

Step 3. Download the datasets. Click on big-data-3.zip: 

Click on the Download button: 

In the dialog, select Save File: 

Click OK, and the file big-data-3.zip file will be downloaded to the Downloads directory. 



Step 4. Uncompress the datasets. Open a terminal shell by clicking on the terminal shell icon in 

the top toolbar. 

 

In the terminal, run: 

cd Downloads 

unzip -o big-data-3.zip 

Step 5. Install tools. Change directories to big-data-3 and run setup.sh to install tools and 

libraries. 

cd big-data-3 

./setup.sh 

During the setup process, Anaconda will give you a series of prompts. First, press enter to 

continue the installation: 

 

Next, read and accept the license: 

 

Next, press enter to accept the default installation location: 

 

Next, enter yes when it asks if you want to prepend the install location to PATH: 

 



The setup of tools and datasets should continue. 

Finally, source $HOME/.bashrc: 

source $HOME/.bashrc 

 

Querying Data 
Step 1. Open a terminal window and start Postgres shell. Open a terminal window by clicking 

on the square black box on the top left of the screen. 

 

Next, start the Postgres shell by running psql: 

 

Step 2. View table and column definitions. We can list the tables in the database with 

the \d command: 

 

The database contains three tables: adclicks, buyclicks, and gameclicks. We can see the column 

definitions of the buyclicks table by running \d buyclicks: 

 

This shows that the buyclicks table has seven columns, and what each column name and data 

type is. 



Step 3. Query table. We can run the following command to view the contents of 

the buyclicks table: 

select * from buyclicks; 

The select * means we want to query all the columns, and from buyclicks denotes which table to 

query. Note that all query commands in the Postgres shell must end with a semi-colon. 

The result of the query is: 

 

You can hit <space> to scroll down, and q to quit. 

Step 4. Filter rows and columns. We can query only the price and userid columns with the 

following command: 

select price, userid from buyclicks; 

The result of this query is: 

 

We can also query rows that match a specific criteria. For example, the following command 

queries only rows with a price greater than 10: 

select price, userid from buyclicks where price > 10; 

The result is: 



 

Step 5. Perform aggregate operations. The SQL language provides many aggregate 

operations. We can calculate the average price: 

 

We can also calculate the total price: 

 

The complete list of aggegrate functions for Postgres 8.4 (the version installed on the Cloudera 

VM) can be found here: https://www.postgresql.org/docs/8.4/static/functions-aggregate.html 

Step 6. Combine two tables. We combine the contents of two tables by matching or joining on a 

single column. If we look at the definition of the adclicks table: 

 

We see that adclicks also has a column named userid. The following query combines 

the adclicks and buyclickstables on the userid column in both tables: 

select adid, buyid, adclicks.userid 

from adclicks join buyclicks on adclicks.userid = buyclicks.userid; 

This query shows the columns adid and userid from the adclicks table, and the buyid column 

from the buyclickstable. The from adclicks join buyclicks denotes that we want to combine these 

two tables, and on adclicks.userid = buyclicks.userid denotes which two columns to use when 

the tables are combined. 

https://www.postgresql.org/docs/8.4/static/functions-aggregate.html


The result of the query is: 

 

Enter \q to quit the Postgres shell. 

TODO 
1. Get familiar with Postgres by visiting its site https://www.postgresql.org/ and reading the 

following article “Abbas Butt. Powering Big Data Processing in Postgres with Apache Spark 

https://www.enterprisedb.com/blog/powering-big-data-processing-postgres-apache-spark” 

2. Answer the questions: 

- how many records in all tables? 

- describe the scheme of “adclicks” table 

- what categories are present in “adcatagory” column of “adclicks” table? What category is 

most frequent one? 

3. Make a list of aggregate functions for Postgres. Write down an example of usage of aggregate 

function other then ‘avg’ or ‘sum’. 

4. Try to combine all three tables in one query. 

 

https://www.postgresql.org/
https://www.enterprisedb.com/blog/powering-big-data-processing-postgres-apache-spark
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